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A. MODE ADMINISTRATEUR  

Créer une ressource 
1. Se loguer en tant qu’administrateur. 

2. Aller sur Administration, puis sur le Module Ressources (Fig. 1). 

3. Cliquer sur Gestion des ressources (Fig. 1). 
 

 

 

Fig. 1 

» Module Ressources 
■  Gestion des ressources 

■  Liste des groupes de langue pour les ressources 

■  Gestion des types de ressources 

■  Gestion des mots clés 

■  Gestion des Thèmes 

■  Exporter la table des ressources 

 

4. En haut de l’écran de la nouvelle page cliquer sur le lien ■ Créer une ressource. 

5. Remplir les champs obligatoires , marqués d’un astérisque, et ajouter la ressource ou l’adresse URL.  

a. Titre . Par convention, on fera l’économie des majuscules quelle que soit la langue: ne les mettre que 
là où elles sont vraiment nécessaires (noms propres, noms de lieux, etc.). 

b. Auteur   

i. Par convention, on écrira l’initiale du prénom en majuscule suivie d’un point et le nom en entier, 
ex. : François Dunant > F. Dunant. 

ii. S’il y a plusieurs auteurs, on les sépare avec des virgules. 

iii. S’il s’agit d’une organisation, et si le nom n’est pas trop long, on écrit le nom en entier ; si le 
nom est trop long, ou l’organisation est plus connue par son acronyme, on écrit l’acronyme 
(éventuellement mettre dans la rubrique ‘Notes’ le nom complet) en majuscules et dans la 
langue de la ressource. Exs. : World Bank ou Banco Mundial, CEPES, UNDP. 

iv. S’il s’agit du BIT, il y a certaines conventions pour garder une certaine uniformité et faciliter la 
recherche : 
 

Pour : 

 

Ecrire: 

Programme STEP ILO-STEP 

BIT-STEP 

OIT-STEP 

SEC/SOC ILO, Social Security Department 

BIT, Département de la sécurité sociale 

OIT, Departamento de Seguridad Social 

Bureau régional à New 
Delhi (M. Socquet) 

 

ILO-STEP SRO for South Asia 

ou ILO SRO for South Asia 

c. Année . Quatre chiffres. 

d. Ajouter la ressource 

i. Via le ‘Browse…’. D’où qu’on prenne le fichier, le système l’enregistre et le garde à un autre 
endroit (bdd géante), comme s’il faisait une copie. Il n’est donc pas absolument nécessaire 
d’enregistrer toutes les ressources ajoutées dans le dossier 
I:\STEP\Platform\aGIMI\CONTENUS\… 

ii. Via l’adresse URL si le fichier électronique n’est pas disponible ou si nous avons seulement 
l’autorisation de mettre un lien. 
Important :  Lorsque les ressources n’appartiennent pas au BIT, il faut demander une 
autorisation de mise en ligne au détenteur des droits d’auteur avant de publier la ressource sur 
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n’importe quelle application : GIMI, GESS, AMIN ou ACYM. Des fois, il ne suffit pas que 
l’auteur du document donne son accord pour qu’on puisse le mettre en ligne, car il peut ne pas 
avoir les droits d’auteur, mais l’institution ou organisation qui publie le document. 
 
Un exemple d’e-mail d’autorisation de mise en ligne se trouve dans l’Annexe 1 (p.10), annexe. 
Veiller à adapter le message. 

e. Ajouter l’image  de couverture (voir annexe 2) à ce moment a l’avantage d’un affichage immédiat de 
celle-ci ; l’ajout postérieur, lorsqu’on édite l’entrée, retarde l’affichage de quelques heures, voire 
quelques jours.  

 

6. Puis, cliquer sur  Envoyer  en bas de l’écran. A ce moment, le système donne automatiquement un numéro 
id  à la ressource ajoutée. 

 

7. Revenir sur l’interface administrateur (détail ressource) pour remplir les champs restants. Mais avant il faut 
chercher la ressource ajoutée avec la fonction ‘find’ : CTRL+F et on tape quelques mots du titre ; puis on 
clique sur ‘Editer’ (Fig. 2 et 3). 

 

 
 

 

 

 

 
 

NB. Le numéro id sur GESS est en forme de lien. Lorsqu’on clique dessus on a accès direct à l’affichage de la 
page intermédiaire (fiche) de la ressource telle qu’elle sera vue par l’utilisateur. Ensuite, en cliquant sur ‘back’ en 
haut de la page Internet on revient sur l’interface administration.  

 

8. Remplir les champs optionnels . Les champs sont optionnels pour les utilisateurs, mais l’administrateur doit 
remplir tous les champs sur lesquels il a de l’information. 

a. Ajouter la couverture . Pour une question de poids, l’image doit être un fichier *.jpg au format 95 x 132 
pixels. Ce format est proportionnel à une page A4. Voir Annexe 2 (p.11) pour plus de détails. 

b. Le champ Notation . C’est l’évaluation que les utilisateurs font des ressources en attribuant des étoiles 
(1-5 étoiles). Dans l’interface admin ce champ ne doit pas être rempli et n’est pas actif. 

c. Le champ Taille kb  se remplit automatiquement. La limite de poids fixée pour un document normal 
(pdf, word, power point, excel, etc.) est de 1MB pour qu’il puisse être téléchargé facilement.  
 
Important :  Utiliser tous les moyens possibles pour réduire la taille des fichiers : conversion en pdf 
avec si possible diminution de la résolution (si possible jusqu’à 150 dpi), réduire la taille des photos, 
etc. Prévoir aussi l’ajout d’un lien plutôt que du fichier. 

Supprime la ressource 
définitivement. 
 

 

 

 

 

Supprime le fichier ajouté 
(pdf, word,  etc.) mais pas 
la ressource. 

 

Fig. 2 

GIMI 

numéro id  

Fig. 3 

GESS 

numéro id  

Supprime la ressource 
définitivement. 
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d. Les champs ISBN et ISSN correspondent à des numéros donnés dans certains documents publiés ; 
l’info se trouve dans la page de copyright. Il est de plus en plus courant d’avoir deux numéros ISBN, 
un pour le document imprimé et l’autre pour le document électronique (pdf) ; il faut noter les deux dans 
le formulaire admin. 

e. Les champs Editeur  et Publié par  ne sont pas toujours faciles à remplir et l’information n’est pas 
toujours nécessaire, surtout quand tout est clair sur l’auteur. S’il y a des questions, voir avec Ivón ou 
avec Vicky. En ce qui concerne les publications officielles du Département de la Sécurité Sociale du 
BIT, se référer au document Guidelines for SECSOC publications (pdf disponible dans la bibliothèque 
GESS ou en wiki pour les administrateurs depuis la page Admin). 

f. Le champ URL pour commander la ressource  est utile pour les ressources en vente qui ne sont pas 
téléchargeables gratuitement et dont on dispose d’une adresse URL vers laquelle on renvoie 
l’utilisateur, s’il veut acheter la ressource (par exemple, les livres publiés par SECSOC). 

g. Thèmes . Il faut se familiariser avec les thèmes de GIMI et GESS pour indexer correctement une 
ressource. 

h. Mots clés.  Veiller à choisir les bons mots clés. Il vaut mieux en mettre peu mais qui soient 
représentatifs, que beaucoup de mots clés approximatifs ou qui ne correspondent pas aux thèmes 
principaux de la ressource. Souvent, il suffit de lire le titre, la table de matières, l’intro et 
éventuellement les conclusions pour trouver les mots clés. Voir dans Annexe 3 (p.14) la liste des mots 
en trois langues (ES, EN, FR) ; elle peut changer. 

i. Le champ Sélectionner  les pages où la news sera affichée  n’est pas actif sur GESS ni GIMI ; il est 
pertinent pour ACYM, AMIN et le site de la Concertation. 

j. Langue . Une langue par ressource, c’est-à-dire, une fiche par ressource. S’il existe plusieurs versions 
d’un même document, la gestion de langues se fait avec le formulaire de gestion de langues (voir petit 
‘o’ plus bas). 

k. En plus des champs obligatoires, les cases ‘Publiée’, ‘Copyright’ et ‘Validée’ sont les conditions 
nécessaires pour qu’une ressource s’affiche dans la bibliothèque. 

i. On coche la case Validée  lorsque la ressource a été approuvée ou conseillée par un expert 
(STEP sur le terrain, Valérie, Christian, staff de Secsoc, etc.) ou si on considère que les 
ressources concernent les thèmes de Gimi ou de Gess.  

Important :  En plus de la pertinence du contenu, il faut être attentif à ce que la ressource ne 
contienne pas des propos contraires à la philosophie du BIT. En cas de doute consulter Valérie, 
Vicky ou Ivón. 

ii. On coche la case Copyright  quand il n’y a aucun problème d’autorisation de mise en ligne de 
la ressource. 

iii. On coche la case Publiée  lorsque les deux cases antérieures sont conformes et après 
vérification du formulaire complet. Le responsable de la bibliothèque (Ivón) doit valider les 
ressources ajoutées et cocher cette case si tout est conforme. Il faut donc annoncer par email 
(avec titre de la ressource et no. id) tout ajout de ressource au responsable pour ‘publication’ 
dans la bibliothèque Gimi/Gess. 

Important :  Important : Cette case est différente de la case « Publique » qui s’affiche dans le 
formulaire d’ajout de ressources depuis les espaces de travail. La case doit être cochée 
seulement si l’espace est public. 

l. Le champ Information connexe  peut contenir très peu de texte. Il sert surtout à mettre des liens vers 
des compléments d’information sur la ressource, soit vers d’autres sites internet ou d’autres 
documents. Par exemple, pour la newsletter de la Concertation, on peut ajouter un lien vers le site de 
la Concertation : 
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Dans le formulaire admin, il faut utiliser le langage html pour ajouter un lien. Un éditeur de html a été 
récemment ajouté afin de faciliter la saisie de texte, avec des liens par exemple. Lorsqu’on ajoute un 
lien externe, il est important d’ajouter la balise qui permettra d’ouvrir le lien sur une nouvelle page afin 
de ne pas sortir de GESS ou GIMI.  Ce principe est valable pour tout lien externe dans les plates-
formes. 
 
Pour ce faire, il faut ajouter à l’adresse URL en question la balise target=" blank", en cliquant d’abord 
sur  « Source », puis insérant manuellement la balise, comme ceci : 
 

 
 
 
 
 
 

m. Le champ Note  sert à ajouter des informations complémentaires sur une ressource s’il y en a. Dans 
ce champ on peut mettre un texte de la même longueur qu’un résumé (env. 3000 caractères, y 
compris les balises html), d’autres liens, l’adresse e-mail d’un contact, etc.  

n. Ensuite il y a quatre champs Résumé , un par langue des plates-formes (EN, ES, FR) plus une 
quatrième langue qui peut être choisie à partir du menu déroulant situé au-dessus du champ. 

Le principe est de mettre le résumé dans la langue de la ressource, c’est-à-dire un résumé par fiche. 
Mais il y a des cas particuliers, par exemple, lorsqu’un document n’existe que dans une langue mais 
vu son importance, on considère que l’utilisateur devrait avoir accès au moins au résumé dans sa 
langue. Alors on ajoute le résumé dans une autre ou d’autres langues sur la même fiche. 
 
Le texte des résumés demande pour certains signes du code html. En général, on peut taper 
directement les lettres accentuées le box résumé ; on peut aussi faire un copy/paste à partir de word 
par exemple, mais il se peut que la police change (style et taille) ; il vaut mieux donc de copier le texte 
d’abord vers un ‘note pad’ puis dans la boîte résumé. Vérifier l’affichage ou retaper le texte, si 
nécessaire. 

Voir l’Annexe 4 (p.17) pour des conseils sur la rédaction de résumés .  

o. Langues  d’une même ressource. Le groupe de ressources sert à mettre un lien automatique entre 
versions différentes d’une même ressource. 

Lorsque la ressource est nouvelle ou lorsqu’elle existe en une seule langue, vers la fin du formulaire 
administrateur il y a deux cases comme ceci : 

 0  Ajouter 

Sur la case de gauche il faut ajouter le no. id du groupe de langues puis cliquer sur  Ajouter. 

Fig. 3 
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Pour créer un groupe, on revient sur la page administration du Module Ressources (voir Fig.1) et on 
clique sur ■ Liste des groupes de langues pour les ressources. On arrive sur cette page : 
 

 
 
Cette page permet de faire deux actions: ajouter et  supprimer un groupe. La suppression d’un groupe 
ne veut pas dire qu’on supprime la ressource. Si on devait supprimer un groupe, il faudra faire les 
changements nécessaires dans les ressources qui faisaient partie du groupe : leur assigner le bon n° 
id du groupe ou l’effacer selon le cas. 

i. Cliquer sur Ajouter un groupe, et donner un nom. Pour retrouver les groupes sans difficulté, il 
est conseillé de : 

- donner un nom court et qui permette de s’en souvenir facilement plus tard ; 

- composer le nom avec : 1° type de document, 2° acronyme de l’organisation, 3° si nécessaire, 
ajouter d’autres éléments utiles. Par exemple, les sites web on les nomme par le type de 
ressource + deux points + l’acronyme ou le nom de l’organisation (Web: Microfinance 
Gateway) ; 

- éviter de mettre le titre en entier de la ressource, cela prend trop de place et ce n’est pas très 
utile. 

ii. Cliquer sur  Ajouter  et ensuite sur revenir pour prendre le n° id du groupe. On ajoute ce 
numéro dans le formulaire admin des ressources concernées à l’endroit indiqué dans la Fig. 5, 
puis on appuie sur Ajouter. Par exemple, lorsque le groupe id = 131 aura été ajouté à toutes 
les ressources concernées, le formulaire administrateur des différentes versions se présente 
comme ceci : 
  

Groupe actuel : 131  Supprimer 

 0  Ajouter  version en FR id=2630

 2550 

 2631 

 Anglais 

Espagnol 

Supprimer 

Supprimer 

   

 Groupe actuel : 131  Supprimer 

  0  Ajouter  version en EN id=2550

 

 2630 

 2631 

 

Français 

Espagnol 

Supprimer 

Supprimer 

     

 Groupe actuel : 131  Supprimer 

  0  Ajouter  version en ES id=2631

 

 2550 

 2630 

 

Anglais 

Français 

Supprimer 

Supprimer 

Fig. 4 

Fig. 5 
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Et le résultat suite à une recherche se présente avec des liens sur lesquels on peut cliquer 
menant à la fiche de la ressource dans les autres langues disponibles, comme ceci: 
 
» Articulations entre les régimes légaux de sécurité 
sociale et les mécanismes de protection sociale […] 
A. Cœur, C. Jacquier, V. Schmitt-Diabate, J. Schremmer, 2007 
Anglais    Espagnol 

Contrôle des résultats 
1. Depuis l’interface utilisateur, il faut vérifier la présentation correcte des données : police correcte, sauts de 

ligne, listes à puces, liens corrects et qui fonctionnent, image de couverture ajoutée, etc.  

2. Lorsqu’on ajoute des ressources dans la bibliothèque, il est conseillé de travailler avec deux écrans en 
même temps : un pour remplir le formulaire admin ; l’autre en interface utilisateur pour voir les changements 
faits. 

Editer une ressource 
Vu le nombre grandissant des ressources dans la bibliothèque, la liste complète a été divisée par pages  de 20 
ressources (comme les news) ce qui change le mode de recherche (avant il suffisait de faire un CTRL + Find). 

1. Identifier les ressources qui doivent être validées ou éditées au moyen de la table export. Pour ce faire, aller  
sur Administration > Module Ressources > Exporter la table des ressources (voir Fig. 1). A partir du tableau, 
filtrer les données selon besoin : 

a. par date de création (ajout) de la ressource 

b. par les critères : Validée=0, Copyright=0, Publiée=0 

c. par le numéro id du créateur 

Aller ensuite à l’interface admin et faire les changements nécessaires. 

2. Identifier les ressources qui doivent être validées ou éditées au moyen du formulaire de recherche, en allant 
sur Administration > Module ressources : 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Cliquer sur » Rechercher une ressource  ou sur » Gestion des ressources > ■ Rechercher une 
ressource (menu en haut, à droite), selon des critères pertinents : 

a. no. id de la ressource, si connu 

b. une partie du titre 

c. nom de l’auteur 

d. pays, etc. 

Faire les changements nécessaires 

 

Fig. 6 
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Valider les ressources ajoutées par un utilisateur 
1. Se loguer en tant qu’administrateur. 

2. Identifier les ressources en suivant les pas 1 ou 2 de la section précédente « Editer une ressource ». 

3. Réviser les ressources concernées une par une, compléter les champs. 

4. Si tout est en ordre, cocher les trois cases : Publiée, Copyright, Validée. 

5. Envoyer éventuellement un e-mail de remerciements à l’utilisateur (externe) pour sa contribution. 

6. Les administrateurs des différentes applications (GIMI, GESS, ACYM, AMIN) sont responsables de l’ajout et 
la validation de nouvelles ressources. 

Gestion des dossiers, répertoire I:\ (GIMI Genève) 
La gestion des dossiers de la bibliothèque a commencé sur GIMI, l’arborescence de GIMI est aussi pour cette 
raison plus complexe. Avec le développement de GESS la gestion est maintenant partagée entre les deux plates-
formes, en principe : en GESS les ressources typiques de GESS (extension de la sécurité sociale); en GIMI les 
ressources typiques de GIMI (micro-assurance).  

 

 

1. Dossier  général où on garde les ressources de la bibliothèque. Comme indiqué au point 5.d.i, il n’est pas 
nécessaire de garder tous les documents dans ce dossier.  

Ce dossier contient 3 grandes ramifications : documents principaux  (no. 3), images  (no. 8) et résumés  
(no. 10). Ce dernier n’est presque plus utilisé, car on fait les résumés directement dans le formulaire 
administrateur. 

2. Dans ce dossier on met toutes les réponses aux demandes d’autorisation de mise en ligne. 

3. Ici on garde les documents principaux  (fichiers word, pdf, excel, power point, etc.) A noter que les films 
sont gardés ailleurs vu leur taille (voir avec Maxime). 

Ce dossier inclut 3 ramifications : les documents principaux eux-mêmes (no. 3), les documents avant 
classification (no. 5) et les documents lourds à convertir (no. 6). 

4. Important : Avant classification. Dans ce dossier on met systématiquement toutes les ressources qu’on 
reçoit de l’extérieur ou que l’on trouve soi-même et qui n’ont pas encore été ajoutées dans la bibliothèque. 
Une fois que ces fichiers sont ajoutés, on change le nom original du fichier par le numéro id + les lettres dp  

1 

2 

3 

4 

 

5 

 

 

 

6 

7 

 

 

8 

9 

10 

11 

Emplacement des fichiers 
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et on déplace le fichier dans le dossier Fichiers docs principaux (no. 3). Si c’est nécessaire, on peut créer 
des sous-dossiers à l’intérieur. 

5. Attente autorisation. S’il s’agit d’un document pour lequel on a demandé une autorisation de mise en ligne, 
on l’ajoute quand même dans la bibliothèque et on déplace le fichier dans ce dossier. Si c’est nécessaire, on 
peut créer des sous-dossiers à l’intérieur. 

6. Originaux lourds à convertir.  Un exemple ce sont les documents de Marc, lesquels il faut souvent convertir 
pour réduire la taille avant de les ajouter dans la biblio. Cela fait, on déplace les fichiers convertis (nom 
changé par le numéro id de la ressource) dans le dossier Fichiers docs principaux (no. 3) et les originaux 
dans le dossier Originaux lourds ajoutés ds biblio  (no. 7). Si c’est nécessaire, on peut créer des sous-
dossiers à l’intérieur. 

8. Dossier  où on garde les images  de couverture. Ces fichiers sont en format jpg et mesurent 95 x 132 pixels. 
Ils sont nommés d’après le numéro id de la ressource, p. ex. 2335.jpg 

9. Dans ce dossier on garde les images dont le document principal n’a pas encore de numéro id. Lorsqu’on a 
ce numéro, on change le nom du fichier en attribuant le no. id de la ressource et on le déplace dans le 
dossier principal Images (no. 8). 

Gestion des dossiers, répertoire I:\ (GESS Genève) 
 

 
 

Il n’y a que deux dossiers dans GESS : un pour les images de couverture et l’autre pour les fichiers principaux. 

Une fois qu’une ressource est ajoutée dans la bibliothèque, on change le nom original du fichier par le numéro id 
et on le garde dans le dossier ‘Main resources’. Si c’est nécessaire, on peut créer des sous-dossiers à l’intérieur. 

B. MODE UTILISATEUR  

Créer une ressource 
1. Se loguer. 

2. Depuis votre espace personnel aller dans la section « Dernières ressources ajoutées dans la bibliothèque » 
puis cliquer sur « Ajouter une ressource » ou depuis le menu horizontal (haut) cliquer sur RESSOURCES > 
BIBLIOTHÈQUE et cliquer sur « Ajouter une ressource » 

3. Remplir les champs obligatoires , marqués d’un astérisque, et ajouter la ressource ou l’adresse URL.  

a. Titre 

b. Auteur. Par convention, on écrira l’initiale du prénom en majuscule suivie d’un point et le nom en 
entier, ex. : François Dunant > F. Dunant. 

c. S’il y a plusieurs auteurs, on les sépare avec des virgules.  

d. Année 

e. Région 

f. Ajouter la ressource 

i. Via le ‘Browse…’.  

ii. Via l’adresse URL si le fichier électronique n’est pas disponible. 

g. Mots clés. Ajouter au moins deux mots clés de la liste. Pour ajouter plusieurs mots clés, il faut les 
choisir avec la souris en maintenant enfoncée la touche CTRL. De même, pour enlever un mot clé, il 
faut le pointer avec la souris en appuyant sur la touche CTRL. 

4. Remplir autant de champs optionnels  que possible.  

a. Sous-titre 

Emplacement des fichiers 
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b. Type 

c. Langue 

d. Thème. Pour choisir plusieurs thèmes à la fois, procéder comme pour les mots clés. 

e. Pays. Pour choisir plusieurs pays à la fois, procéder comme pour les mots clés. 

f. Résumé. Option d’ajouter un résumé en plusieurs langues (anglais, français, espagnol et / ou une 
quatrième langue à choix via le menu déroulant). 

5. Puis cliquer sur  Envoyer  en bas de l’écran. 
 
Important :  Les ressources que l’utilisateur ajoute doivent être validées par l’administrateur avant d’être 
publiées dans la bibliothèque (administrateur, voir point : Créer une ressource, 8k). 

6. L’utilisateur arrive sur la liste de ses contributions : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Gérer sa liste de contributions 
Lorsque l’utilisateur ajoute une ressource, il arrive sur une page qui liste toutes les ressources qu’il a ajoutées 
(http://www.ilo.org/gimi/RessShowUserRessource.do ou ...gimi/gess/RessShowUserRessource.do). Celles-ci ne 
sont pas encore validées par l’administrateur et ne sont donc pas encore publiées dans la bibliothèque et 
apparaissent sous la section « Ressources en attente de validation ». Les ressources passent à liste en dessous 
« Ressources validées » au fur et à mesure que l’administrateur les valide. 

En cliquant sur ■ Plus d’info…, l’utilisateur peut voir la fiche de présentation de la ressource ajoutée, telle qu’elle 
apparaîtra lorsqu’elle sera validée et publiée (avec des ajustements faits par l’administrateur, si nécessaire) ; et il 
peut les supprimer en cliquant sur ■ Supprimer. Une fois validées, l’utilisateur en peut plus les supprimer, par 
contre, il peut ajouter des commentaires.▐ 
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C. ANNEXES 

Annexe 1. Message e-mail de demande d’autorisation 
 

 

 

Dear …, 

 

The Social Security Department of the International Labour Office through its STEP Programme has 
developed an Internet platform on the extension of social security to disadvantaged groups: Global 

Extension of Social Security (GESS). 

 

The platform aims to be a comprehensive knowledge development system based, inter alia, on an 

Internet application and a network of experts worldwide. One means of attaining the platform's main 
objective is by producing, disseminating and capitalizing on relevant knowledge among experts and 

people interested in social protection issues. 

 

In this context, we hereby request your permission to add the following articles published by Elsevier to 
the platform's resource centre:  

 

1) "Adverse selection in a voluntary Rural Mutual Health Care health insurance scheme in China", by H. 

Wang et al., April 2006.http://www.sciencedirect.com/science?_ob=ArticleURL&_udi=B6VBF-4JT3S8G-
2&_user=1991186&_coverDate=09%2F30%2F2006&_rdoc=1&_fmt=&_orig=search&_sort=d&view=c

&_acct=C000055288&_version=1&_urlVersion=0&_userid=1991186&md5=c51b946f2f3f241f7c40eefb9
1ec094b  

 

2) "Health care in China: The role of non-government providers", by Y. Liu et al., 

2006.http://www.hsph.harvard.edu/phcf/publications/Liu.Berman.Yip.2006.pdf  

 

The articles would be accessible on the platform through links to the relevant websites listed above.  All 

references to Elsevier and to the articles' authors will be duly mentioned. 

 

Thank you very much for your attention. 

 

Looking forward to hearing your decision soon, 

[signature] 

 

------------------------------------------------------------- 

1. Présentation de la plate-forme, à adapter selon la plate-forme dont il s’agit. 

2. Référence à l’organisation qui publie. 

3. Titre(s) de l’ouvrage + lien où on l’a trouvé (lien de l’organisation ou de la maison d’édition): à adapter selon les 
cas. 

4. Mentionner comment la plate-forme mettra à disposition l’info + assurer que les références de rigueur seront 
faites. 

1 

2 

4 

3 
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Annexe 2. Comment ajouter des images dans la biblio thèque 
 

Deux types d’images sont créés et enregistrés dans la bibliothèque : pour illustrer une ressource et pour ajouter 
dans des pages génériques (thème, pays, wiki, etc.) ou dans le glossaire. Ici seulement le premier cas est traité. 

 

 

���� Illustrer une ressource de la bibliothèque 
Lors de l’ajout d’une ressource dans la bibliothèque, il faut ajouter aussi une image pour l’illustrer. C’est un détail 
graphique important et qui permet aux utilisateurs de mieux reconnaître une ressource.  

Un utilisateur fera rarement cette action, ça prend du temps, il peut éventuellement envoyer un fichier image par 
e-mail. C’est donc à l’administrateur de la créer pour lui. 

 

Quelle image ajouter ? 
Le principe est d’ajouter une image représentative de la ressource. Elle peut changer en fonction du type de 
ressource, par exemple: 

• pour les documents, tels que : articles, newsletters, documents de conférence, d’atelier, ESS 
Paper series, livres, études de cas, etc., on ajoutera la couverture  

• pour les sites internet on peut ajouter, par exemple, un « print screen  » de la page d’accueil 

• dans certains cas on peut ajouter aussi un logo  (s’il est disponible et dans un bon format pour 
qu’il ne soit pas trop flou), ou un autre détail graphique  de la ressource. 

 
Quelles sont les caractéristiques de l’image ?  

• Format par défaut: rectangle vertical qui mesure 95x132 pixels  ou env. 2.5x3.5 cm. (proportionnel à une 
page A4 portrait). 

• Type de fichier :  jpg , de cette façon les images pèsent en moyenne 13KB . 

 
Comment créer ou modifier une image ?  

Créer une image dépend du matériel qu’on a à disposition, mais quel que soit le matériel, le but est d’arriver à 
avoir une petite image, légère, proportionnée, et si possible avec un titre qui soit lisible. 

 

Il faut un éditeur d’images . Ici, on utilisera Irfanview . 

 

Pas à suivre pour une image standard , par exemple une couverture A4 en portrait. 

 

S’il n’y a pas de fichier électronique disponible, il faut scanner l’image  : 

1. Placer le document dans le scanner 

2. Ouvrir le programme IrfanView, cliquer sur File > Acquire/Batch scanning  (le scanne s’ouvre) 

3. Choisir le paramètre true color + cadrer l’image (veiller à ne pas dépasser le cadre du document pour 
éviter des zones grises). 

4. Dans menu cliquer sur Tools et changer les paramètres :  
- resize : Scale = 50% 
- change resolution : 150 

5. Cliquer sur Return to (on revient vers IrfanView) 

6. Redimensionner l’image, en cliquant sur Menu > Image > Resize/Resample (garder la case 
« Preserve aspect ratio » cochée) :  Width : 95 px    Height : 132 px 

7. Cliquer sur zoom + recadrer l’image > Menu : Edit > Crop selection 

8. Sauvegarder l’image (voir le rappel sur l’administration des fichiers à la fin du document). 

 

Si le fichier électronique est disponible (par exemple, un pdf, une présentation power point, un site internet, etc.), 
il faut copier l’image  : 

1. Ouvrir le fichier en question et faire un copier/coller de l’image voulue sur Irfanview.  
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2. Un fichier word est le cas le plus simple, mais s’il s’agit d’un fichier pdf par exemple, il faut avant : 

a. Ouvrir le fichier et moduler le zoom à env. 60% 

b. Faire un « print screen » de la page 

c. Copier/coller sur Paint 

d. Recadrer l’image pour ne prendre que la page voulue + copier. 

3. Ouvrir Irfanview et coller l’image. 

4. Aller sur le menu et cliquer sur Image > Resize/Resample 

5. Adapter la taille en pixels > Set new size : et taper Width : 95    
Comme on garde cochée la case « Preserve aspect ratio » le paramètre Height : se met 
automatiquement (132px).  

6. On clique sur OK. 
Important :  Il arrive souvent que la valeur de Height soit supérieure ou inférieure à 132. Que faire ? 

a. Si Width = 95 et Height > 132, on passe au point 7. 

b. Si Width = 95 et Height < 132, on tape d’abord 132 sur Height ; Width sera alors supérieur à 95 
� on passe au point 7. 
 
Ces valeurs on les voit sur la barre grise inférieure d’Irfanview 

7. Découper l’image pour la faire rentrer dans les valeurs par défaut et pour corriger les éventuelles 
zones grises.  

a. On fait un zoom assez grand pour avoir une bonne visibilité (la taille réelle ne change pas) 

b. On recadre l’image avec la souris en cliquant sur l’angle inférieur droit et en la déplaçant vers le 
haut et à gauche jusqu'à ce qu’on arrive aux valeurs désirées (celles-ci s’affichent sur les 
barres d’Irfanview à mesure qu’on déplace la souris). Puis, on lâche la souris. 
 

 
 

c. On va sur le menu et on clique sur Edit > Crop selection. 

8. On enregistre l’image. 

 

Pas à suivre pour une image non standard , par exemple une image en format paysage (présentation power 
point - ppt), une plaquette, une page internet, etc. 

Les lignes générales sont les mêmes, mais il faut veiller à ne pas déformer l’image. On traite ici l’exemple d’un 
fichier ppt. Avec un peu de pratique on arrive à l’adapter à d’autres formats. 

Valeurs avec nouveau 
cadrage. 

Valeurs 
établies au 
début. 

Recadrage avec la 
souris en partant de 
l’angle inférieur 
droit. 

Zoom + 

On clique dessus 
plusieurs fois (env. 
4-5) 
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1. On ouvre une page blanche en word, format A4 portrait, sans marges , qu’on appellera 
« template_cover ».  On tape 3x Enter. 

2. On ouvre notre fichier ppt et on copie la page qu’on veut prendre comme image et on la colle sur la 
feuille word avec le curseur placé au 2e Enter 

3. Ensuite on agrandit l’image et on la déplace (par ex. la centrer à la verticale et à l’horizontale) de 
façon à ce qu’elle occupe un maximum d’espace dans la page sans être déformée. 

4. Important :  Une fois que l’image est centrée horizontalement, il faut taper autant de Enter que 
nécessaire pour arriver au bas de la page, sans quoi, la proportion ne sera pas gardée lors du collage 
dans Irfanview. 

5. On fait un CTRL + A (pour prendre même les interlignes vides ou Enter) et on colle sur Irfanview. 

6. A partir de là, on reprend le processus d’une page standard à partir du point 4. 
 

 
 

 

Comment ajouter l’image dans le formulaire administ rateur ? 
1. Lorsque l’image de couverture est créée, aller sur le formulaire administrateur de la ressource et 

ajouter le fichier image dans le champ prévu à cet effet et cliquer sur Envoyer. 

2. En principe, l’image ajoutée depuis l’administration s’affiche immédiatement mais il se peut que 
l’action prenne quelques minutes, voire quelques heures. 

 

Pou rappel : Administration des fichiers 
1. Si la ressource est déjà répertoriée dans la bibliothèque, il faut : 

a. nommer le fichier avec le no. id correspondant 

b. garder le fichier dans le dossier correspondant : 
…aGIMI\CONTENUS\PF_SPEC_Cres_033\Images   ou 
…aGESS\CONTENUS\LIBRARY\Cover 

2. Si la ressource n’est pas encore répertoriée, il faut : 

a. donner un nom provisoire au fichier 

b. le garder quelque part en attendant d’avoir le no id de la ressource 

c. renommer le fichier et le déplacer au dossier correspondant 

 

 

4. Déplacement dans la 
page. Interlignes jusqu’en 
bas de la page. 

3. Agrandissement. 2. Copy/paste original. 
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Annexe 3. Listes des thèmes, mots clés et types de ressources en trois 
langues 

 

Mots clés 
ES EN FR 

Generalidades, panorama (sobre 
el microseguro) Overview (microinsurance) Aperçu (sur la micro-assurance) 

Articulaciones Linkages Articulations 

Seguro privado Private insurance Assurance privée 

Seguro social Social insurance Assurance sociale 

Campaña (de la OIT sobre 
seguridad social para todos) Campaign Campagne 

Desempleo Unemployment Chômage 

Contabilidad Accounting Comptabilité 

Contabilidad nacional National accounting Comptabilité nationale 

Convenios contractuales Contractual arrangement Contractualisation 

Contrato / convención Contractual agreements Contrat / convention 

Supervisión Supervision Contrôle / surveillance 

Convenio de la OIT ILO convention Convention de l'OIT 

Diagnóstico Diagnosis Diagnostic 

Niños Children Enfants 

Espacio proyecto sobre Senegal Senegal project space Espace projet Sénégal 

Estudio actuarial Actuarial study Etude actuarielle 

Estudio de factibilidad Feasibility study Etude de faisabilité 

Evaluación de necesidades Needs assessment Etudes des besoins 

Evaluación (de sistemas de 
microseguro, de seguridad social) Evaluation Evaluation 

Mujeres Women Femmes 

Financiación de la seguridad 
social Social security financing Financement sécurité sociales 

Funcionarios (empleados de la 
administración pública) Civil servants Fonctionnaires 

Género Gender Genre 

Administración Management Gestion 

Gestión del riesgo Risk management Gestion du risque 

Global Social Trust Global Social Trust Global Social Trust 

Impacto Impact Impact 

Discapacidad Disability Incapacité / invalidité 

Legislación Legislation Législation 

Mercadotecnia Marketing Marketing 

Mercadotecnia social Social marketing Marketing social 

Maternidad Maternity Maternité 

Microseguros Microinsurance Micro-assurance 

Microfinanza Microfinance Microfinance 

Modelos Models Modèles 

Mutuales de salud Mutual health organizations Mutuelles de santé 
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ES EN FR 

Normas OIT y legislación ILO Standards & Legislation Normes BIT et législation 

Oferta de cuidados de salud 
(asistencia, servicios médicos) Health care supply Offre de soins de santé 

Socio-agente Partner-agent Partner-agent 

Pensión de vejez Pensions Pensions de retraite 

Personas de edad avanzada Senior citizens Personnes âgées 

Pertinencia Relevance Pertinence 

Planes de acción nacionales National action plans Plans d'action nationaux 

Política social Social policy Politique sociale 

Prestaciones en metálico Cash transfers Prestations en espèces 

Proyecto sobre legislación Legislation project Projet législation 

Protección social básica Basic social protection Protection sociale de base 

Protección social de salud Social health protection Protection sociale en santé 

Recomendación de la OIT ILO recommendation Recommendation de l'OIT 

Redistribución Redistribution Redistribution 

Regulación Regulation Régulation 

Salud Health Santé 

Seguridad social Social security Sécurité sociale 

Social budgeting Social budgeting Social budgeting 

SPER SPER SPER 

Estadísticas Statistics Statistiques 

Estrategias nacionales National strategies Stratégies nationales 

Seguimiento Monitoring Suivi 

Sistemas de base comunitaria 
(basados en la comunidad) Community-based schemes Systèmes à base communautaire 

Third-party administrators (TPA) Third-party administrators (TPA) Third-party administrators (TPA) 

Obreros del transporte Transportation workers Travailleurs des transports 

Trabajadores migrantes Migrant workers Travailleurs migrants 

Trabajadores rurales Rural workers Travailleurs ruraux 

VIH / SIDA HIV / AIDS VIH / SIDA 
 

Thèmes 
ES EN FR 

Generalidades, panorama (sobre 
el microseguro) Overview (microinsurance) Aperçu (sur la micro-assurance) 

Articulaciones Linkages Articulations 

Seguro social Social insurance Assurance sociale 

Convenios contractuales Contractual agreements Contractualisation 

Viabilidad (estudio de factibilidad) Feasibility Faisabilité 

Financiación Financing Financement 

Administración Management Gestion 

Global Social Trust Global Social Trust Global Social Trust 

Legislación / Regulación Legislation / Regulation Législation / Régulation 

Mercadotecnia Marketing Marketing 

Microseguros Microinsurance Micro-assurance 
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ES EN FR 

Normas OIT y legislación ILO Standards & Legislation Normes BIT et législation 

Pertinencia Relevance Pertinence 

Políticas y estrategias nacionales National polices and strategies 
Politiques et stratégies 
nationales 

Prestaciones en metálico Cash transfers Prestations en espèces 

Prestaciones universales Universal benefits Prestations universelles 

Protección social en salud Social health protection Protection sociale en santé 

Asistencia médica Health care Soins de santé 

Estrategias / Planes de acción Strategies / Action plans Stratégies / Plans d'action 

Seguimiento-Evaluación / 
Diagnóstico rápido 

Monitoring-Evaluation / Rapid 
appraisal 

Suivi-Evaluation / Diagnostic 
rapide 

Sistemas articulados Linked schemes Systèmes articulés 
 

Types de ressources 
ES EN FR 

Artículo (prensa u otro) Article Article 

Convenio (con prestadores de 
servicios médicos) / MoU 

Agreement / MoU (Memorandum 
of Understanding) Accord offre de soins 

Taller (documentos sobre) Workshop Atelier 

Base de datos Database Base de données 

Folleto Brochure Brochure 

Conferencia (documentos de) Conference Conférence 

Convenio de la OIT ILO Convention Convention de l'OIT 

Documento de trabajo Working paper Document de travail 

Expediente (varios documentos 
sobre un mismo tópico) Dossier Dossier 

ESS Paper series ESS Paper series ESS Paper series 

Estudio de caso Case study Etude de cas 

Película (video) Film Film 

Guía / manual Guide / manual Guide / manuel 

Entrevista Interview Interview 

Inventario Inventory Inventaire 

Boletín informativo Newsletter Lettre d'information 

Libro (o capítulo) Book (or chapter) Livre (ou chapitre) 

Programa informático Software Logiciel 

Módulo de capacitación Training module Module de formation 

Presentación power point Presentation Présentation 

Informe Report Rapport 

Artículo científico (informe) Research paper Rapport scientifique 

Sitio Internet Website Site internet 

Texto jurídico Legal text Texte juridique 
 

 



 17

Annexe 4. Indications pour rédiger des résumés 
 

Extrait de Sources d’information de l’OIT : Techniques d’indexation – résumés, Unité 5 : Résumés en texte libre, 
http://www.ilo.org/public/french/support/lib/indexati/unit5/unit5 [avril 2006] 

 

Règles générales pour les résumés en texte libre 

Ecrire le résumé en un seul paragraphe. 

Le texte du résumé peut être basé sur un passage du document lui-même, lorsqu’un tel passage résume 
clairement et précisément les concepts qu’il s’agit d’exprimer. 

Commencer le résumé avec un verbe (analyse, compare, etc.) ou un nom (rapport de...). 

 

But du résumé en texte libre 

[…] Un résumé en texte libre est un bref exposé du contenu d’un document ou l’indication des[sic] ses principales 
caractéristiques, sans interprétation ni critique. 

Les principales caractéristiques d’un bon résumé so nt les suivantes: 

Essentiel : 
Le résumé doit se concentrer sur le contenu essentiel des documents ou sur leurs principaux accents, et 
distinguer ce qui est essentiel de ce qui est secondaire. 

Objectivité: 
L’indexeur ne doit ni déformer ni donner un jugement de valeur, interpréter ou tirer des conclusions à partir du 
document. L’objectivité implique que l’indexeur évite de qualifier le document comme "excellent", "inhabituel" ou 
"faisant autorité". 

L’auteur du document peut prétendre décrire un phénomène "unique", mais l’on ne peut guère accepter cette 
déclaration de sa part sans preuve. Il ou elle peut seulement chercher à rendre son travail plus attrayant. 

Exactitude: 
Le résumé doit refléter exactement le contenu du document. 

Clarté: 
Pris dans sa globalité ou dans chacune de ses phrases, le résumé doit être clair et précis quant à sa signification. 
Le lecteur ne doit jamais être rendu perplexe par ce que le résumé essaye de communiquer. 

Concision: 
Un résumé est un condensé, limité en longueur; par conséquent l’indexeur doit toujours utiliser le moyen 
d’expression le plus économique. 

Style: 
Du début jusqu’à la fin, le style d’un résumé devrait être soigné: les expressions argotiques et les contractions 
doivent être évitées. Il faut utiliser des phrases complètes, à l’exception des locutions verbales telles que: 
"Describes..." [en anglais] 

Le résumé peut résumer une partie du document seule ment,  plutôt que le document dans son ensemble. 

Parfois un des sujets couverts dans un document nécessite une explication à travers un résumé en texte libre, 
tandis que les autres sujets couverts dans le même document ne nécessite aucune explication. Le problème s’est 
posé de savoir si expliquer dans le résumé un seul des sujets présents dans un document ne donnerait pas trop 
d’importance à ce sujet. 

La solution consiste à utiliser une phrase qui montre au lecteur que ce sujet n’est pas le principal ou le seul sujet 
couvert dans le document. Par exemple: 

"Prend en considération...", "Examine brièvement...", "Un chapitre couvre...", "Mentionne..." 
"Touche...", "Contient un chapitre sur..." 
---------------------------------------------------------------------------------------------------------------- 
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Dans une approche différente , le résumé peut se faire en répondant aux questions suivantes : 

 

1. Quel est l’objectif et le champ du document ou de la ressource ? 

2. Comment est-il structuré ? 

3. A qui s’adresse t-il (ou elle) ? 

 

Ce type de résumé peut s’appliquer, par exemple, à des ressources du type guides ou manuels. 

 

------------------------------------------------------------------------------------------------------------------------------------------------------ 

 

Le portail ELDIS proposait jusqu’en 2006 une rubrique sur les résumés pour ses utilisateurs (il semble qu’on n’y 
ait plus accès). Ci-dessous une courte transcription : 

 

Writing the perfect abstract 
 
Content  

Imagine you are a researcher or policy maker, looking at an abstract on the internet or in an e-mail: 

 

• How much time do you have to read it? 

• Does it catch your eye? 

• Does it look interesting? 

• Does it tell you what you need to know? 

 

What do you need to know about the document? 

• How it fits into what you already know 

• If it offers anything new or different 

• What changes to current thinking it suggests 

• What it helps you to do 

 

Writing for the Internet 

• The abstract will be read on screen and will be e-mailed to subscribers 

• Internet users are notoriously impatient 

• Policy makers and practitioners are generally very busy and need information fast 

• They know a lot about their subject – they don’t need general introductions 

• They don’t want to read something they already know 

 

 
The Full Abstract  

Purpose:  To tell you if you should read the document. Is the document new/interesting/what you are looking for? 
It will no t replace the need to read the actual document. 

 

We expect different types of documents to require different types of abstract, for example policy briefings will be 
different from practical manuals. 

 

Length:  About 400 words. More if ther is a complicated/multiple messages: The abstract will be read on screen or 
in an e-mail, not in a book so it needs to be short.  If you think that the abstract (if slightly longer) ca replace the 
need to see the actual document, then make it slightly longer. 

 

Style: 

• The focus of the abstract is the conclusion of the paper not  the introduction which is usually well 
known general information. What does the paper actually say , its recommendations and conclusions 
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• The abstract needs to contain key words for search purposes. 

• Write as clearly and as simply as possible. 

• Keep sentences short and don’t use unnecessary words eg. adjectives, adverbs 

• Don’t repeat ideas or concepts 

• Remove advertising by the author/publisher eg “This is the most important paper on this subject for 
the last ten years…” 

• Write in the present tense. 

• Write as third person, rewrite personal pronouns, eg author’s “we then looked at…” Instead say “ the 
article looks at” or “looks at”. 

• Break into short paragraphs, each focused on a concept. Subdivide these using bullet points to bring 
out conclusions of research. Can be multiple bulleted lists (eg if there are separate (and interesting) 
lists of factual finding s and policy conclusions/recommendations). 

• Highlight using bold not italics (html code: <b>,</b>) 

• When writing an abstract, the best places to look i n the document are its own abstract (if 
available: but note that author abstracts don’t alw ays include conclusions), executive 
summary, introduction and conclusions sections . 

 

 

 

 


